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READ CAREFULLY BEFORE USING

Canon Software License Agreement
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS BOX.
BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.
This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE
SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND THE USER
MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND PROMPTLY RETURN THE SOFTWARE TO
YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.
1. LICENSE:  Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single

computer.  You may physically transfer the SOFTWARE from one computer to another provided that the
SOFTWARE is used on only one computer at a time.  You shall not install or use the SOFTWARE on a
network, multiple CPU, multiple site arrangement, or any other hardware configuration where the
SOFTWARE is accessible to more than one CPU or to more than one user.
With respect to the sound and image data (“Data”) contained in the Software, which are to be downloaded
to the applicable Canon digital camera product, Canon grants you a personal, non-exclusive license to use
the Data on a single Canon digital camera product only.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER,
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up purposes, or copy the
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original for
back-up purposes.  Any other copying of the SOFTWARE is a violation of this Agreement.  You must
reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES:  Neither Canon, nor its subsidiaries, dealers or distributors will be responsible for
providing maintenance or support for use of the SOFTWARE.  No updates, fixes or support will be made
available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose, maintain and
match the hardware and software components of your computer system.  Thus Canon does not guarantee
uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet
your requirements.  THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND WITHOUT WARRANTY OR
CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same
without charge when returned by you at your expense to your point of purchase and proven to be defective
upon inspection.  The Replacement CD-ROM will be warranted for the remainder of the original ninety (90)
day warranty period of the defective CD-ROM.  The limited warranty does not apply if the failure of the CD-
ROM resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other
than the original user of the SOFTWARE.
EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIARIES,
DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR
ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, CONSEQUEN-
TIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVEN-
IENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE
ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY
ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY
OF SUCH THIRD PARTY.
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SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE ON
THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO
YOU.

5. TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of
all copyright interests in the SOFTWARE unless earlier terminated.  You may terminate this Agreement by
destroying the SOFTWARE.  This Agreement will also terminate without notice to you if you fail to comply
with any of the terms of this Agreement and you must then promptly return the SOFTWARE.  In addition,
Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting of
“commercial computer software” and “commercial computer software documentation,” as such terms are
used in 48 C.F.R. 12.212 (Sept 1995).  Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through
227.72024 (June 1995), all U.S. Government End Users shall acquire the SOFTWARE with only those rights
set forth herein.  Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501,
Japan.

7. EXPORT RESTRICTIONS:  You agree to comply with all export laws and restrictions and regulations of the
country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of any such
laws and restrictions and regulations, or without all necessary approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of
competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or
tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

9. CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the Software in the United
States of America shall be governed and construed in all respects in accordance with the laws and
regulations of the State of New York, without reference to choice of law principles.  The terms of this
Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the
province of Ontario.

10.OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE
belong to Canon, its affiliated corporations and third party licensors.  Your use of the SOFTWARE is subject to
the laws of the United States, and Canada, and other applicable copyright and trademark laws, and nothing
in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party
licensors under such laws.  You only own the CD-ROM media in which the Software is stored.  Except as
expressly provided herein, no license or right, express or implied, is hereby conveyed or granted by Canon to
you for any intellectual property of Canon.  Nothing contained in Paragraph 1 shall be construed to give
Canon any ownership rights in any images, graphics or textual material that you save in connection with the
Software.
You may not modify, remove or delete any or all copyright notices (i) which are contained in the Software,
including any copy thereof, and (ii) which are on the original CD-ROM and on the medium of a back-up copy
made pursuant to Section 2 above.

11.ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ
THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF
AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF.  NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.
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Read This First

You can connect a camcorder with a USB terminal to the PC using a USB cable
to download still images recorded on the memory card of the camcorder. You
can also use the software provided to sort, store, and print still images.

Disclaimer
• While every effort has been made to ensure that the information contained

in this guide is accurate and complete, no liability can be accepted for any
errors or omissions. Canon reserves the right to change the specifications of
the hardware and software described herein at any time without prior
notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in
a retrieval system, or translated into any language in any form, by any
means, without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost
data due to mistaken operation or malfunction of the camcorder, the
software, memory cards (MultiMediaCards or SD Memory Cards), personal
computers, or peripheral devices, or due to use of a memory card not
formatted by a Canon camcorder.

Trademark Acknowledgments
• Canon is a registered trademark of Canon Inc.
• ArcSoft, the ArcSoft logo, ArcSoft PhotoImpression and ArcSoft

VideoImpression are trademarks or registered trademarks of ArcSoft, Inc.
• Adobe, Adobe Acrobat and Adobe Photoshop are trademark of Adobe

Systems Incorporated.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of

Apple Computer Inc., registered in the United States and other countries.
• Microsoft®, Windows® and Windows NT® are either registered trademarks

or trademarks of Microsoft Corporation in the United States and/or other
countries.

• Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.

Copyright © Canon Inc. 2002 All rights reserved.

Safety Precautions
• Do not play the supplied CD-ROM(s) in any CD player that does not support

data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer from hearing loss
from listening with headphones to the loud sounds of a CD-ROM played on
a music CD player.
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Checking Supplied Accessories
Use the following accessories to download recorded images from a memory
card to your computer.
• IFC-300PCU USB Cable

• Canon DIGITAL VIDEO SOLUTION DISK
• ArcSoft Camera Suite CD

- Windows users: Move on to p. 8.
- Macintosh users: Move on to p. 73.
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Windows  System Requirements

Please install the software on a computer meeting the following minimum
requirements.

Computer Model: IBM PC/AT compatible
OS: Windows 98 (First or Second Edition)

Windows Millennium Edition (Windows Me)
Windows 2000
Windows XP
* Proper operation is not guaranteed on an OS that

has been upgraded from a previous version.
CPU: Pentium 150 MHz or better

Windows XP: Pentium 300 MHz or better
RAM: Windows 98: 32 MB or more

Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/
Windows 2000/Windows XP systems with built-in
USB ports

Free Hard Disk Space: • Canon Utilities
- ZoomBrowser EX: 120 MB or more  (Including the

PhotoRecord printing program)
- PhotoStitch: 40 MB or more

• Canon Camera TWAIN Driver: 25 MB or more
• Canon Camera WIA Driver: 25 MB or more
• ArcSoft PhotoImpression: 125 MB or more
• ArcSoft VideoImpression: 30 MB or more

Display: 800 × 600 pixels/256 colors (8 bit) or better, 1,024 ×
768 pixels/High Color (16 bit) or better is
recommended
(800 x 600 pixels/High Color (16 bit) is required to
use ArcSoft PhotoImpression or ArcSoft
VideoImpression)

• The USB interface is only supported for those computers that come with
Windows 98/Windows Me/Windows 2000/Windows XP preinstalled and have
built-in USB ports.

• Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
• Proper operation is not guaranteed for all computers that meet the above

requirements.
• A CD-ROM drive is required to install the software.
• Connect the USB cable directly to one of the computer’s main USB ports. The

interface may not function correctly if the camcorder is connected via a USB hub.
• The connection may not operate correctly if you are using other USB devices,

excluding USB mice or keyboards, at the same time. If this occurs, disconnect
the other devices from the computer and try reconnecting the camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.



9

W
in

d
o

w
s

E

What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained
on the CD-ROMs.

Canon DIGITAL VIDEO SOLUTION DISK

■ USB TWAIN Driver (Windows 98, Windows 2000)
This driver for Windows 98/Windows 2000 loads camcorder still images/
movies into TWAIN-compliant programs, such as ArcSoft PhotoImpression.

■ USB WIA Driver (Windows Me, Windows XP)
This driver for Windows Me/Windows XP starts the Scanners and Cameras
Wizard to automatically download camcorder still images/movies to the
computer. It also allows you to copy camcorder still images/movies using
standard file copying procedures in Windows Explorer (but it cannot upload
computer files to the camcorder).

■ ZoomBrowser EX (  37)
• Downloading still images/movies from a memory card to your computer.
• Categorizing and Organizing Large Volumes of Images*.
• Searching and Organizing Images Chronologically*.
• Creating Mail Attachments from Images*.

■ PhotoRecord (  60)
• Laying Out and Printing Still Images.
• Printing Indexes.

■ PhotoStitch (  63)
• Merging Panoramic Images.

*: For instructions on these features, refer to the ZoomBrowser EX Software
User Guide.

How to view the ZoomBrowser EX Software User Guide

In order to view the ZoomBrowser EX Software User Guide, it is required that
Adobe® Acrobat® Reader is installed on your computer. If it is not, install it
according to “How to install Adobe Acrobat Reader” below.

1. Place the Canon Digital Video Solution Disk in the computer’s
CD-ROM drive.
The installer panel will be displayed.

2. In the installer panel, click [ZoomBrowser EX Software Guide].
The guide will be displayed.

• If the installer panel does not appear automatically, open the [Readme] and
[English] folders on the CD-ROM and double-click the [ZOOMBROWSER EX
GUIDE.PDF] file.
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How to install Adobe Acrobat Reader
1. Place the Canon Digital Video Solution Disk in the computer’s

CD-ROM drive.
2. Open the [Readme], [Acrobat-English] folders.
3. Double-click the [ar405eng.exe] file to start the installer.
Follow the on-screen instructions to install Adobe Acrobat Reader.

ArcSoft Camera Suite CD-ROM

■ ArcSoft PhotoImpression
This program allows you to easily convert still images to sepia color, apply
other special effects, or to edit them and create greeting cards and
calendars.

■ ArcSoft VideoImpression
This program provides simple procedures for editing and applying special
effects to movies, or  attaching them to your e-mail.

This instruction manual explains how to install the software, what you can do
with the main features and how to operate them. For more detailed
operational instructions, refer to the ZoomBrowser EX Software User Guide
(PDF format) or the Help menu of each software program.

What Can Be Accomplished with the Software
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Installer Panel

Installing the Software

Installing from the Canon DIGITAL VIDEO SOLUTION DISK

Installation Precautions
• Before you attach the camera to the computer with the USB cable for the first

time, you must install one of the following drivers onto the computer.
Windows 98/Windows 2000: USB TWAIN Driver
Windows Me/Windows XP: USB WIA Driver

• There are several limitations to the USB WIA Driver. Before you install it, please
read the ”USB WIA Driver Installation Precautions” (  14).

1. Close any programs that are running.
• Users of Windows 2000, Windows XP Professional must first log in as

an Administrator to install programs.

2. Set the Canon DIGITAL VIDEO SOLUTION DISK in the
computer’s CD-ROM drive.
• The installer panel opens automatically.
• If the installer panel does not appear automatically, use the following

procedures to display it.
1. Double-click the [My Computer] icon on the desktop to open it and

double-click the CD-ROM icon.
2. Double-click the [Setup] icon.

3. Click [Digital Video Software Installation].

4. Read the license agreement and click the [Yes] button.

5. Confirm the target folder for the installation and click the
[Next] button.
• Normally, select (C:\Program Files\Canon).



12

Installing the Software

6. Confirm the program selection and click the [Next] button.
• The installation starts.
• Follow the on-screen messages to proceed with the installation.
• If the “Digital signature not found” message appears, click the [Yes]

button.

7. Select your camcorder model name and click the [Next]
button.

8. After the installation is complete and the installer panel
displays again, click the [Exit] button.
• The installer panel disappears.

9. Remove the DIGITAL VIDEO SOLUTION DISK once the
installation is complete so that the proper driver may be
installed.

 Notes:
• The DIGITAL VIDEO SOLUTION DISK is not needed for installing the USB

driver. Remove the disk once the installation is complete.
• Continue with the procedures on page 14 to install the driver software to

allow the camcorder to be connected to a computer via the USB interface
and download images.

• For uninstalling programs contained in the DIGITAL VIDEO SOLUTION DISK
such as the ZoomBrowser EX, see “Uninstalling the Software” (  70).
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Installing from the ArcSoft Camera Suite CD-ROM

1. Place the ArcSoft Camera Suite CD-ROM into the drive.

2. Double-click the [My Computer] icon on the desktop
(Windows XP: click the Windows [Start] menu and select [My
Computer]) followed by the [ArcSoft] folder and [Setup]
icon.

3. Select your language and click [OK].
• You can select the software you wish to install. ArcSoft PhotoImpression

is a software for still images and ArcSoft VideoImpression for movies.
• Follow the on-screen instructions.

• For uninstalling ArcSoft PhotoImpression or ArcSoft VideoImpression, see
“Uninstalling the Software” (  70).
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

The installation procedures vary depending on the computer. Check your OS
and proceed to the referred pages.
Windows 98 (  15), Windows Me (  20), Windows 2000 (  24),
Windows XP (  29).

USB WIA Driver Installation Precautions
• You can install the USB WIA Driver if you are using Windows Me/Windows XP. In

addition, you should read the “USB WIA Driver Limitations” below before
installing the driver.

USB WIA Driver Limitations
• When you have set the WIA Driver to start a particular application program when

you connect the camcorder, the program may cause an error message similar to
the following to appear: “TWAIN data source not found. Reinstall the scanner
software.” If this happens, select [WIA-camera model] in the application program
as the TWAIN device.

 Notes:
• USB TWAIN Driver is the driver software for Windows 98 and Windows

2000 that is required to load still images/movies into TWAIN-compliant
programs, such as ArcSoft PhotoImpression and ArcSoft VideoImpression.
Since it is not a stand-alone program, you must always start it from TWAIN-
compliant programs.

• USB WIA Driver can only be used with the USB interface in Windows Me/
Windows XP. When you connect the camcorder to the computer with a USB
cable, the Windows Scanners and Cameras Wizard opens automatically to
assist with downloading. This driver also allows you to use Windows
Explorer to display thumbnails of the camcorder’s still images/movies on the
computer and download still images/movies with standard file copying
procedures.

• If the “Digital signature not found” message appears, click the [Yes] button.
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Windows 98

Installing the USB TWAIN Driver

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• After a moment, a dialog appears, prompting you to insert the disk.

4. Without inserting the DIGITAL VIDEO SOLUTION DISK, click
[OK]. The following dialog appears.

5. Click the [Browse] button.
• The [Choose Folder] dialog appears.

6. Double-click the drive on which you installed the software
(such as C:), and select the [Program Files], [Canon] and
[IXY DVM OPTURA200 TWAIN] folders.

7. When you have selected the folder, click [OK].
• This brings you back to the dialog in step 5.

Windows 98
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

8. Click [OK]. The USB TWAIN Driver will be installed
automatically.

Uninstalling the USB TWAIN Driver

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• A dialog appears, allowing you to select an application program to

start.

4. Click the [Cancel] button.
• If ZoomBrowser is started, close it.

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double-click the [Scanners and Cameras] icon.
• If you cannot find the [Scanners and Cameras] icon, use the procedures

on page 17 to uninstall the driver.

7. Delete the camcorder model name from the [Scanners and
Cameras Properties] list.

• Select the name of your camcorder model and click the [Remove] button.

Your camcorder model name
appears here. If it does not, use
the procedures on page 17 to
uninstall the driver. If a scanner
driver has also been installed, its
name also appears in the list.

Windows 98
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8. Click the [Start] menu and select [Programs], [Canon

Utilities], [IXY DV M, OPTURA200 MC TWAIN Driver] and
[TWAIN Driver Uninstall].
• The uninstall process starts.

Troubleshooting the USB TWAIN Driver Uninstall
If you had problems uninstalling the driver, use the following procedures to
remove it.

 Notes:
Use the procedures below for the following circumstances too.
• If you do not find the [Scanners and Cameras] icon in the [Control Panel].
• If your camcorder model name does not appear in the [Scanners and

Cameras Properties] dialog.
• If you connected the camcorder to the computer via the USB cable before

installing the software/driver on the DIGITAL VIDEO SOLUTION DISK.

Leave the camcorder connected to the computer.

1. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.
• The [System Properties] dialog appears.

3. Click the [Device Manager] tab.

Windows 98
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

5. Double-click the [My Computer] icon on the desktop
followed by the [C:] drive and the [Windows] and [Inf]
folders.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Click the [View] menu and select [Folder Options].
2. Click the [View] tab.
3. Set the [Hidden files] section to [Show all files].
4. Click [OK] to close the dialog.

This makes the [Inf] folder and files in the [Inf] folder visible.

Check here

4. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

1. Select the name of the camcorder model and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
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7. In the [Inf] folder, double-click [Other] folder to open it.

8. Find and delete the [Canon.IncCAP_IDVM] folder.
• If none of the above files are contained in the [Other] folder, you do not

need to delete anything.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

Windows 98



20 Windows Me

Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

Windows Me

Installing the USB WIA Driver

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• After a moment, the Add New Hardware Wizard opens and

automatically installs the USB WIA Driver.
• If you are prompted to restart the computer, restart the computer

according to the on-screen messages.

If you have installed the USB WIA Driver, the Scanners and Cameras Wizard
starts.

Uninstalling the USB WIA Driver

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Scanners and Cameras Wizard appears.

4. Click the [Cancel] button.
• If ZoomBrowser is started, close it.

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double-click the [Scanners and Cameras] folder.
• If you cannot find the [Scanners and Cameras] folder, use the

procedures on page 21 to uninstall the driver.
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7. Delete the camcorder icon from the [Scanners and Cameras]

folder.

• Select the icon of your camcorder model, right-click the mouse button
and select [Delete].

8. Click the [Start] menu and select [Programs], [Canon
Utilities], [IXY DV M, OPTURA200 MC WIA Driver] and [WIA
Driver Uninstall].
• The uninstall process starts.

Troubleshooting the USB WIA Driver Uninstall
If you had problems uninstalling the driver, use the following procedures to
remove it.

 Notes:
Use the procedures below for the following circumstances too.
• If you do not find the [Scanners and Cameras] folder in the [Control Panel].
• If the camcorder icon does not appear in the [Scanners and Cameras] folder.
• If you connected the camcorder to the computer via the USB cable before

installing the software/driver on the DIGITAL VIDEO SOLUTION DISK.

Leave the camcorder connected to the computer.

1. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.
• The [System Properties] dialog appears.

3. Click the [Device Manager] tab.

Your camcorder model name
appears here. If it does not, use
the procedures below to
uninstall the driver. If a scanner
driver has also been installed, its
name also appears in the list.

Windows Me
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Windows Me

4. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

1. Select the name of the camcorder model and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5. Double-click the [My Computer] icon on the desktop followed
by the [C:] drive and the [Windows] and [Inf] folders.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. Set the [Hidden files and folders] section to [Show hidden files and

folders].
4. Click [OK] to close the dialog.

This makes the [Inf] folder and files in the [Inf] folder visible.

Check here
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E6. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

7. In the [Inf] folder, double-click [Other] folder to open it.

8. Find and delete the [Canon.IncCAP_IDVM] folder.
• If none of the above files are contained in the [Other] folder, you do not

need to delete anything.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

Windows Me
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Windows 2000

Installing the USB TWAIN Driver

Users of Windows 2000 must first log in as an Administrator to install the driver.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• After a moment, the Add New Hardware Wizard opens and

automatically installs the USB TWAIN Driver.
• If you are prompted to restart the computer, restart the computer

according to the on-screen messages.

Uninstalling the USB TWAIN Driver

Users of Windows 2000 must first log in as an Administrator to uninstall the driver.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• A dialog appears, allowing you to select an application program to start.

4. Click the [Cancel] button.
• If ZoomBrowser is started, close it.

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double-click the [Scanners and Cameras] icon.
• If you cannot find the [Scanners and Cameras] icon, use the procedures

on page 25 to uninstall the driver.
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7. Delete the camcorder model name from the [Scanners and

Cameras Properties] list.

• Select the name of your camcorder model and click the [Remove]
button.

8. Click the [Start] menu and select [Programs], [Canon
Utilities], [IXY DV M, OPTURA200 MC TWAIN Driver] and
[TWAIN Driver Uninstall].
• The uninstall process starts.

Troubleshooting the USB TWAIN Driver Uninstall
If you had problems uninstalling the driver, use the following procedures to
remove it.

 Notes:
Use the procedures below for the following circumstances too.
• If you do not find the [Scanners and Cameras] icon in the [Control Panel].
• If your camcorder model name does not appear in the [Scanners and

Cameras Properties] dialog.
• If you connected the camcorder to the computer via the USB cable before

installing the software/driver on the DIGITAL VIDEO SOLUTION DISK.

Users of Windows 2000 must first log in as an Administrator to uninstall the
driver.

1. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.

Your camcorder model name
appears here. If it does not, use
the procedures below to
uninstall the driver. If a scanner
driver has also been installed, its
name also appears in the list.

Windows 2000
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Windows 2000

3. Click the [Hardware] tab.

4. Click the [Device Manager] button.

5. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

1. Select the name of the camcorder model, right-click the mouse
button and select [Delete].

Check here

2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

• Remove all copies of your camcorder model name that appear in
the [Other Devices] or [Imaging Devices] categories, or that appear
more than once in one category.
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7. Look for the file starting with [OEM*].
• A number such as ”0” or “1” will appear in place of the asterisk (*)

above. You will also find another file called [Oem*.pnf], which will have
the same number as the [Oem*] file. The two constitute one set.

• There may be many file sets starting with “Oem”.
• If you double-click the [Oem*] file, the Windows Notepad program will

start and show the file contents. Click each [Oem*] file until you find
one that contains “*** Canon Camera Driver Setup File***” in its first
line. When you find the correct file, note down its name and close the
Notepad window.

6. Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder
Use the following procedures to show all files and folders.

1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders]

category to the [Show hidden files and folders] option.
• If [Hide extensions for known file types] is selected, remove its

check mark.
4. Click [OK] to close the dialog.

This makes the [Inf] folder and the files in the [Inf] folders visible.

Windows 2000
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8. Delete the [Oem*] file set.
• Delete all [Oem*] and [Oem*.pnf] files, taking great care to delete the

correct files.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

Windows 2000
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Windows XP

Installing the USB WIA Driver

Users of Windows XP Professional must first log in as an Administrator to install
the driver.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The USB WIA Driver will be installed automatically.

When the installation is complete, select the application you wish to start.

 Note:
• Please set your computer to automatically start an application when the

camcorder is connected to the computer. Please set the computer to start
either ZoomBrowser EX or the Scanners and Cameras Wizard. If neither of
these is selected the computer may not operate properly.

Setting an Application to Start Automatically

You can set your computer to automatically start an application when the
camcorder is connected to the computer via the USB cable. Please set the
computer to start either ZoomBrowser EX or the Scanners and Cameras
Wizard. If neither of these is selected the computer may not operate properly.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• If the Event Dialog appears, click [Cancel] to close it.

Windows XP
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Windows XP

4. From the [Start] menu, click [Control Panel] and the [Printers
and Other Hardware] icon.

5. Click the [Scanners and Cameras] icon.

6. Select the camcorder icon and click the [View device
properties] icon in [Imaging Tasks].

The name of your camcorder
appears.
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When you wish to start ZoomBrowser EX automatically
1. Set [Select an event] to [Default]. Set the [Actions] section to [Take

no action].
2. Set [Select an event] to [(camcorder name) Connected] and in the

[Actions] section, set [Start this program] to [Canon ZoomBrowser
EX].

When you wish to start the Scanners and Cameras Wizard automatically
1. Set [Select an event] to [Default]. In the [Actions] section, set [Start

this program] to [Microsoft Scanners and Cameras Wizard].
2. Set [Select an event] to [(camcorder name) Connected], and set the

[Actions] section to [Take no action].

8. Click [OK].
• Next time, either ZoomBrowser EX or the Scanners and Cameras Wizard

will start automatically.

Uninstalling the USB WIA Driver

Users of Windows XP Professional must first log in as an Administrator to
uninstall the driver.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

Windows XP
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Windows XP

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Scanners and Cameras Wizard appears.

4. Click the [Cancel] button.
• If ZoomBrowser is started, close it.

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double-click the [Scanners and Cameras] icon.
• If you cannot find the [Scanners and Cameras] icon, use the procedures

on page 33 to uninstall the driver.

7. Delete the camcorder icon from the [Scanners and Cameras]
folder.

• Select the icon of your camcorder model, right-click the mouse button
and select [Delete].

8. Click the [Start] menu and select [All Programs], [Canon
Utilities], [IXY DV M, OPTURA200 MC WIA Driver] and [WIA
Driver Uninstall].
• The uninstall process starts.

Your camcorder model name
appears here. If it does not, use
the procedures on page 33 to
uninstall the driver. If a scanner
driver has also been installed, its
name also appears in the list.
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Troubleshooting the USB WIA Driver Uninstall
If you had problems uninstalling the driver, use the following procedures to
remove it.

 Notes:
Use the procedures below for the following circumstances too.
• If you do not find the [Scanners and Cameras] icon in the [Printers and

Other Hardware].
• If the camcorder icon does not appear in the [Scanners and Cameras] folder.
• If you connected the camcorder to the computer via the USB cable before

installing the software/driver on the DIGITAL VIDEO SOLUTION DISK.

Users of Windows XP Professional must first log in as an Administrator to
uninstall the driver.

1. Click the Windows [Start] menu and click [Settings], [Control
Panel], [Performance and Maintenance] and [System].

2. Click the [Hardware] tab.

3. Click the [Device Manager] button.

4. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

Windows XP

Check here
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1. Select the name of the camcorder model, right-click the mouse
button and select [Delete].

2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

• Remove all copies of your camcorder model name that appear in
the [Other Devices] or [Imaging Devices] categories, or that appear
more than once in one category.

5. From the [Start] menu, click [My Computer], [C:], [Windows]
and [Inf] folder in succession.
If the [Inf] Folder Is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.

1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders]

category to the [Show hidden files and folders] option.
• If [Hide extensions for known file types] is selected, remove its

check mark.
4. Click [OK] to close the dialog.

This makes the [Inf] folder and the files in the [Inf] folders visible.
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• A number such as “0” or “1” will appear in place of the asterisk (*)

above. You will also find another file called [Oem*.pnf], which will have
the same number as the [Oem*] file. The two constitute one set.

• There may be many file sets starting with “Oem”.
• If you double-click the [Oem*] file, the Windows Notepad program will

start and show the file contents. Click each [Oem*] file until you find
one that contains “*** Canon Camera Driver Setup File***” in its first
line. When you find the correct file, note down its name and close the
Notepad window.

7. Delete the [Oem*] file set.
• Delete all [Oem*] and [Oem*.pnf] files, taking great care to delete the

correct files.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

Windows XP
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2. The driver (Windows 98/Windows 2000: USB TWAIN Driver,
Windows Me/Windows XP: USB WIA Driver) will be installed
the first time you connect the USB interface.

Connection Precautions
• Make sure the camcorder is being powered using the power adapter before

connecting it to a computer.
• Be sure to install the DIGITAL VIDEO SOLUTION DISK before you connect the

camcorder to the computer.
• Connect the camcorder directly to a USB port on the computer; not through

a hub. The connection may not operate correctly through a hub.
• The connection may not operate correctly if you are using other USB

devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.

• Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface. If it does happen,
never disconnect the USB cable. Try to awaken the computer with
the camcorder in the connected state. Some computers will not
awaken properly if you disconnect the camcorder while they are in
standby mode. Please refer to your computer manual for instructions
regarding its standby mode.

1. Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
• You do not need to turn off the computer for this procedure.
• Refer to your computer manual for the location of the computer’s USB

ports.
• See your camcorder instruction manual for connecting instructions.

Connecting the Camcorder to a Computer

USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer
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Canon ZoomBrowser EX Icon

Downloading Still Images/Movies with the ZoomBrowser EX

• Observe following precautions when the camcorder’s card access indicator is
flashing (the camcorder is reading or writing from or to the memory card).
Failure to do so may cause memory card data to become corrupted.

– Do not remove the memory card or detach the USB cable.
– Do not turn off the camcorder or the computer.
– Do not change the position of the POWER switch or the TAPE/CARD

switch.
• Format the memory card with the camcorder or from the Camera Window

(  42).
• Still images/movies recorded onto the memory card or downloaded to the

hard disk are important original data files. Create a copy of the file first
before working on it on your computer.

Starting the ZoomBrowser EX

1. Insert the memory card to the camcorder.
• When connecting a PC card reader, see “Using a PC Card Reader/

Writer” (  66).

2. Connect the Power Adapter to the camcorder.

3. Connect the camcorder to the computer using the supplied
USB cable (  36).

4. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

5. Double-click the [Canon ZoomBrowser EX] icon on the desktop.
• The first time ZoomBrowser EX starts, a confirmation message appears

asking whether you wish to register the [My Pictures] folder in
ZoomBrowser EX.  Click [Yes] if you plan to use the My Pictures folder.

• ZoomBrowser EX starts and the ZoomBrowser EX Automation Wizard
appears.

6. Select [Display images in the Camera Window] and click
[Finish].

Windows 98/Windows 2000
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7. Confirm that [USB] and your camcorder model name are
selected and click the [OK] button.
• Thumbnail versions of the camcorder still images/movies are displayed

in the Camera Window.

 Notes:
• When an enormous volume of still images/movies (such as 500 or more) is

recorded onto one memory card, transferring them to a computer may take
very long.

• In the ZoomBrowser Automation Wizard, you can set the ZoomBrowser EX
to automatically carry out an action when you start it by connecting your
camcorder to the PC with the camcorder prepared for communications.

• A dialog with the previously selected automated settings will appear the
next time you start ZoomBrowser EX.
1. To use these settings unchanged, click the [Start] button.
2. To do nothing, click [Cancel].
3. To change the settings, click [Modify Settings], select the action and click

[Finish].
• For more details, please refer to the PDF manual, “ZoomBrowser EX

Software User Guide” (  9).

Setting the ZoomBrowser EX to Start Automatically

Use the following procedures to have ZoomBrowser EX start automatically
without showing the Event dialog.

1. With the camcorder connected to the computer via the USB
interface, double-click the [My Computer] icon on the
desktop, followed by the [Control Panel] folder and
[Scanners and Cameras] icon or folder.

2. Select the icon of your camcorder model.

3. Click the [Properties] button and the [Events] tab.
• A list of application programs that can be automatically started is

displayed.

4. Remove the check mark from all programs except
ZoomBrowser EX and click [OK].
• You have now set ZoomBrowser EX to start automatically the next time

the camcorder is connected.
• If you wish to shut off the auto start, place a check mark in the [Disable

device events] option.
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Starting the ZoomBrowser EX

For Windows XP Users:
Do not rotate the image in the [Windows Picture and Fax Viewer] or in the
explorer view. The file format of the original image will be changed and the
image can no longer be displayed in the ZoomBrowser EX or on the camcorder.

1. Insert the memory card to the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Connect the camcorder to the computer using the supplied
USB cable (  36).

4. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Scanners and Cameras Wizard automatically opens. Click the

[Cancel] button to close the Wizard.
Windows XP: ZoomBrowser EX will start immediately when it has been
set to auto start in the “Setting an Application to Start Automatically”
section (  29).

5. Double-click the [Canon ZoomBrowser EX] icon on the
desktop.
• ZoomBrowser EX starts and the Browser Window appears.
• The first time ZoomBrowser EX starts, a confirmation message appears

asking whether you wish to register the [My Pictures] folder in
ZoomBrowser EX.  Click [Yes] if you plan to use the My Pictures folder.

6. Click [Canon Camera] in the Tree View area.
• Thumbnail versions of the camcorder still images/movies are displayed

in the Camera Window.

Windows Me/Windows XP
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Setting the ZoomBrowser EX to Start Automatically (Windows Me)

Use the following procedures to have ZoomBrowser EX start automatically
without showing the Event dialog. For Windows XP, see “Setting an
Application to Start Automatically” (  29).

1. With the camcorder connected to the computer via the USB
interface, double-click the [My Computer] icon on the
desktop, followed by the [Control Panel] and [Scanners and
Cameras] icon.

2. Double-click the icon of your camcorder model.

3. Click the [Events] tab.

4. In the [Actions] section, set [Start this program] to [Canon
ZoomBrowser EX].
• You have now set ZoomBrowser EX to start automatically the next time

the camcorder is connected.
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* Movies are displayed with the first scene as a still image, indicated with a
movie icon.

 Notes:
About the other buttons
• [SELECT]: Selects or deselects all images.

[ROTATE]: Rotates the image (90 degrees counterclockwise/90 degrees
clockwise/180 degrees).
[IMAGE INFO]: Displays the number of pixels and file size of the selected
image.

The ZoomBrowser EX Camera Window
The Camera Window opens when a connection to a camcorder is initiated.
Still images/movies will be displayed as thumbnail (small) images.
Buttons are activated when a still image/movie is selected.

Thumbnail
Still images and movies* are 
displayed reduced in size.

Delete Button
Deletes selected still 
images/movies.

Download Button
Copies selected 
still images/movies 
onto the computer 
(      44).

Upload Button
Copies still images from 
the computer onto the 
memory card (      67).

Print Button
Selects the printing 
method: Layout or Index.



42

Downloading Still Images/Movies with the ZoomBrowser EX

Input a camcorder owner name here 
(up to 31 characters).

Set the date and time here.

Click this button to synchronize the camcorder 
to the computer’s date and time settings.

Check the battery charge here.

Click this to format the memory card in the camcorder. 

Check the remaining memory capacity here.

• [SLIDE/DPOF]:
· The SLIDE function (selecting a still image to be included in the slide

show) cannot be used.
· The DPOF index print and date/file name settings are not supported by

the camcorder. Therefore, setting or erasing a print mark on the
camcorder will cancel the index print and date/file name setting.

· The [DPOF] setting in the ZoomBrowser EX allows marking up to 998 still
images for printing.

How to Check and Change Various Camera Settings

You can adjust the date, time and owner settings in the Camera Settings
dialog using the computer when the camcorder is connected. You can also
check the battery charge and remaining memory capacity.

1. On the Camera Window, click the [Setup Options] button and select
[Camera Settings] from the menu that displays. In the TWAIN Driver, click
the [Camera Settings] button to open the Camera Settings dialog.

2. Check or change the settings.
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The Browser Window
This section describes the various parts of the Browser Window and explains
how to change the way the control panel is displayed.

Changing the way the control panel is displayed
• Clicking the t button displays the control panel as a floating toolbar. To return to the

original state, click the r button.
• Furthermore, while the control panel is displayed as a floating toolbar, you can place it

under the menu or at the very bottom of the Browser Window.

Image Folder
An image folder is 
a folder (on your 
PC), which has 
been registered in 
ZoomBrowser EX 
for storing still 
images/movies.

Folder
A folder is a 
subfolder of an 
image folder 
that can be 
used to further 
classify images.

Tree View
This is the area in 
the Browser 
Window where 
folders registered 
as image folders 
are displayed.

You can drag this line to 
change the position of 
the boundary between 
the Tree View and the 
Browser Display Area.

Browser Display 
Area
This is the area 
where thumbnails 
of the selected 
image folder and 
folders are 
displayed.

Message Area
This is the area 
where information 
about the selected 
image folder and 
folders is 
displayed.

Control Panel
This area contains buttons that 
allow you to perform a variety of 
functions.

The title bar displays the path (folder hierarchy) to the selected 
image folder or folder.
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Tree View Area

Thumbnail

3. Select the still images/movies you wish to download from
the Camera Window and click the [Download] button.
• Click on thumbnails to select them. The color of the frame(s) around

the thumbnail(s) you selected will change to be blue.
• To select multiple still images/movies, hold down the Shift key or Ctrl key

while clicking.
• Downloaded still images/movies are saved to the computer disk and

appear in the Browser Display Area.

2. Click the new folder in the Tree View area.

Downloading and Saving Still Images/Movies from the Camcorder

1. Create a new folder for saving still images/movies from the
memory card in the camcorder.
• In the Tree View area, right-click the [Image Library One] folder, select

[New Folder] from the pop-up menu and input a folder name. In this
example, we will input “Travel.” Click the [OK] button.
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Browser Display Area

Tree View Area

 Notes:
• The folder you created above normally appears within the [C:\Program

Files\Canon\ZoomBrowser EX\Image Library One] folder. The downloaded
image files are saved to the folder you created.

• You can also download still images/movies by dragging them from the
Camera Window and dropping them on the Browser Display Area or Tree
View area.

• To disconnect the camcorder, click the close box  at the right of the
Camera Window to close it.
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Scroll Mode Button
Switches to and from 
the scroll mode.

Refresh Button
Updates the folder contents.

Register Image Folder Button
Registers the selected folder as an Image Folder.

Zoom Mode Button
Switches to and from the zoom mode.

Scroll Bar

Still images/movies 
inside the sub-folders 
also display.

Still images/movies 
inside the sub-folders 
do not display.

■ Zoom Mode
When you create a folder within a folder, use this mode to display all still
images/movies inside the sub-folder too.

Switching the Display Mode

You can change between the Zoom and Scroll modes to suit your purposes
when images are displayed in the Browser Display Area.

Using Other ZoomBrowser EX Functions

This topic introduces additional, convenient ZoomBrowser EX features (Zoom
Mode/Scroll Mode/Registering a Folder as an Image Folder/Refreshing a Folder).

Using the ZoomBrowser EX Buttons

The bottom of the ZoomBrowser EX window contains the buttons that control
various functions. This topic describes four of those buttons that are
particularly convenient.
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2. Select the folder you wish to register and click the [OK]
button.
• The folder is registered as an Image Folder.

■ Scroll Mode
Use this mode to just display the still images/movies within one folder. When
there are more still images/movies than can fit in the Browser Display Area,
scroll bars appear on the right of the Browser Display Area. The sub-folders
only appear as folder icons in this mode.

■ Registering a Folder as a Image Folder
Folders shown in the Tree View area with a  symbol are called Image Folder.
ZoomBrowser EX only manages still images/movies contained in these folders
and the subfolders nestled within them.

1. Click the [REGISTER IMAGE FOLDER] button.
• The Select Image Folder dialog appears.
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■ Refreshing a Folder
Only image files that are added, copied or edited using ZoomBrowser EX will
display correctly in a folder that is part of a ZoomBrowser EX image folder. If
you move or copy image folders with the Windows Explorer program or edit
still images/movies with another application, the information contained in
ZoomBrowser EX will not be up-to-date. To update a folder, select it and click
the [Refresh] button. This will refresh the still images/movies in the selected
folder and any subfolders within it.

 Note:
• For a more detailed explanation, please refer to the PDF manual,

ZoomBrowser EX Software User Guide (  9) or the ZoomBrowser EX Help
menu.

Playing Back Movies From a Memory Card
When you double-click an image with a movie icon in the Browser Display
Area, QuickTime Player starts and plays back the movie.
• Movies are displayed with the first scene as a still image.

 Note:
• If QuickTime 3.0 or a later version is not already installed on your computer,

install the QuickTime 5.0 program from the Canon DIGITAL VIDEO
SOLUTION DISK.  Place the disk in the CD-ROM drive and click [QuickTime
5.0 Installation] in the installer panel.

1. Double-click a thumbnail with a movie icon.
• QuickTime Player starts.

2. Click the PLAY button in QuickTime Player.
• The movie will be played back.

 Note:
• Do not double-click a movie file (.AVI extension) in the Windows Explorer.

That will start Windows Media Player, which may not support this file type.
To play back movies, double-click the thumbnail with a movie icon on the
ZoomBrowser EX Browser area.

Using Other ZoomBrowser EX Functions
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Saving a Start-up Image to the Memory Card
You can add your favorite images from your computer to the memory card.
This topic explains how to upload a still image saved on your computer as
start-up image to the memory card. Use ZoomBrowser EX to perform this
function.

For a more detailed explanation, please refer to the ZoomBrowser EX Help
menu or PDF manual, “ZoomBrowser EX Software User Guide” (  9).

Displaying the [DVC My Camera] Window

To save a start-up image to the memory card, use the [DVC My Camera]
window. The following explains the procedure for displaying the [DVC My
Camera] window.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• For starting instructions for ZoomBrowser EX, see “Starting the

ZoomBrowser EX” (  37).

4. From the [Edit] menu in the Browser Window, select [My
Camera for Digital Video Cameras].
• The [DVC My Camera] window appears.

 Note:
• ZoomBrowser EX already contains several pre-recorded My Camera Settings

items. You can check these items with the [DVC My Camera] window.
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The [DVC My Camera] Window

Saving the Start-up Image to the Memory Card

You can save the start-up image displayed in the [DVC My Camera] window
to the memory card.

• Image files that do not appear in the [Computer] list of the [DVC My Camera]
window cannot be saved to the camcorder.

• Do not detach the USB cable, turn the camcorder power off, or disconnect the
camcorder from the computer while the My Camera Settings is being saved to
the camcorder.

Add Button
Adds images as start-up
image to the [Computer]
list when clicked.

Displays the start-up
images saved to the
computer.

Displays the start-
up images on the
memory card.

Displays the image
when it is selected.

Delete Button
Deletes start-up
images from the
[Computer] list.

Using Other ZoomBrowser EX Functions
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2. Click the [Close] button to close the window.
• This concludes the process for saving the start-up image to the memory

card.

To use the start-up image on the camcorder, you need to change the start-up
image on the camcorder itself. Please see the Instruction Manual of the
camcorder for these procedures.

Adding New Image Files to the [DVC My Camera] Window

Create a start-up image using an image editing application program, such as
ArcSoft PhotoImpression. Create the file in the JPEG format at a size of 1280 x
960 or 640 x 480 pixels. Image files not in the JPEG format cannot be added.

Once you have created the start-up image and saved it to the computer, use
the following procedures to add it to the [DVC My Camera] window (  50).

1. Open the [DVC My Camera] window, and click the [Add]
button.

1. Select the start-up image you wish to save to the camcorder
from the [Computer] list and click the  button.
• The selected start-up image is displayed in the preview area to the right

and appears in the [Camera] list.
• Start-up images will be saved to the [Dcim] folder in the memory card.

Preview area
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2. Select the file you created in the [Open file] dialog and click
the [Open] button.
• The selected file appears in the [Computer] list.

This concludes the process for adding new data.

You can save the newly created file to the memory card using the procedures
described in “Saving the Start-up Image to the Memory Card” (  50).

 Note:
• To delete a data file, select it and click the [Delete] button.

The newly added data will
appear here

Using Other ZoomBrowser EX Functions
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Windows 98/Windows 2000

Loading Still Images into TWAIN-Compliant Programs

This section explains how to load still images into the computer using the
supplied ArcSoft PhotoImpression software.
For more details, please refer to the PDF manual of ArcSoft PhotoImpression.

To load still images into PhotoImpression, the TWAIN Driver and ArcSoft
PhotoImpression must be correctly installed onto the computer.  For
installation instructions, please refer to “Installing from the ArcSoft Camera
Suite CD-ROM” (  13) and “Installing the USB TWAIN Driver” (  15, 24).

Loading Still Images into ArcSoft PhotoImpression

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Event dialog appears, asking you to select an application program

to start.

4. Click [Cancel].

5. Click the Windows [Start] menu and select [Programs],
[ArcSoft Camera Suite] and [PhotoImpression].
• PhotoImpression starts.

6. Click the [Camera/Scanner] button at the bottom left of the
PhotoImpression window.

7. Select your camcorder model from the [Select Source] list.
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8. Click the  button.

Loading Still Images into TWAIN-Compliant Programs

Loading Still Images with the TWAIN Driver

9. Click the [Camera Connection] button.
• The camcorder’s still images are displayed in the Thumbnail Display

Area.

10.Select the still image(s) you wish to load and click the
 [Transfer Images] button.
• The TWAIN Driver closes and the still image(s) are displayed in the

PhotoImpression window as thumbnails.

11.  Click the [OK] button.
• The acquired still image(s) are displayed in the PhotoImpression’s main

window. To save the acquired still image(s), click the [File] menu of the
image editing software and select [Save as]. Input a file name, change
the file location and set the file format to JPEG (recommended).
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Camera Settings Button
Click here to adjust or check camera settings (    42).

Preferences 
Button
Click here to 
adjust or check 
image
transmission 
settings.

Rotate 90 
Degrees Buttons
Click a button to 
rotate the 
selected still 
image 90 degrees 
left or right.

Image 
Selection
Button

Protection
On/Off
Button Help Button

Check Mark On/Off Button
You can choose a still image 
selection method if you click 
the [Select] button after adding 
a check mark.

Main Buttons
Click these buttons to 
perform the main tasks, 
such as loading still 
images and closing the 
TWAIN Driver.

Image Data Display Area

Display Area for 
Image Folder 
Selection

Image Display Area
Still images display here 
when a camcorder is 
connected.

Comment Box
Input a comment of up to 120 characters 
here. (You cannot input a comment while 
the camcorder is connected.)

Display Mode 
List Box
Click here to select 
between the 
Thumbnail and 
Preview display 
modes.

Display Size 
List Box
Click here to 
select an 
image display 
size.

Image Format 
List Box
Click here to select 
the format of the 
still images you 
wish to display.

Image Transmission 
Mode List Box
Click here to select to 
transmit the selected 
images as a single 
image or as an index 
sheet.

TWAIN Driver Window
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Downloading with the WIA Driver

If you have installed the USB WIA Driver, you have the following alternatives
for downloading still images/movies to the computer.
3 Downloading with the Scanners and Cameras Wizard
3 Downloading with Windows Explorer
3 Downloading with the File Dialog
3 Downloading with Windows TWAIN Source

Downloading with the Scanners and Cameras Wizard [Still Images Only]

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Scanners and Cameras Wizard opens automatically.

4. Click the [Next] button.

5. Select the still image you wish to download and click the
[Next] button.
• To select multiple still images, press and hold the [Ctrl] or [Shift] key on

the keyboard while clicking on images. To select all the images, click
[Select All].

• Windows XP: Confirm that a check mark is on the still image you wish
to download and click the [Next] button.

Windows Me/Windows XP
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6. Specify a file name and save location and click the [Finish]

button.
• The selected still images are downloaded to the specified folder. If you

do not specify a folder, they are saved by default to the [My Pictures]
folder within the computer’s [My Computer] folder.

Downloading with Windows Explorer [Still Images/Movies]
Images can be downloaded to the computer with Windows Explorer just as
you would copy any other file.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Scanners and Cameras Wizard opens automatically.

4. Click the [Cancel] button.

5. Start Windows Explorer, double-click [My Computer] and
select your camcorder’s icon in it.
• The camcorder’s images are displayed as thumbnails in the Explorer

window.
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Downloading with the WIA Driver

6. Copy images to a folder on the hard disk using standard
Explorer file copying procedures.
• Copy by Specifying a Folder

Select a still image/movie in the Explorer window, right-click the mouse,
select [Save] and specify a folder. The still image/movie and its
thumbnail are downloaded to the specified location.

• Windows Me: If you drag a movie file from the Explorer window and
drop it to the specified folder, the [.avi] extension will not be copied.
Add the extension back by selecting [Rename Image].

Downloading with the File Dialog [Still Images Only]
You can select a still image from an image editing program such as ArcSoft
PhotoImpression and save it to the computer. This section explains how to
load still images using ArcSoft PhotoImpression. For more details, please refer
to the PDF manual of ArcSoft PhotoImpression.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Scanners and Cameras Wizard opens automatically.

4. Click the [Cancel] button.

5. Start the image editing program, such as ArcSoft PhotoImpression.
• The camcorder’s images are displayed as thumbnails in the Explorer window.

6. Click the [From file] menu and select [Browse].
• The Open dialog appears.

7. Select [My Computer] and your camcorder’s icon in the file list.
• The camcorder images are displayed as thumbnails.
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8. Select the still images you wish to download and click the

[Open] button.
• The selected still images are loaded into the program.
• To save the loaded still images, click the [File] menu and select [Save

As].  Input a file name and change the file location and format settings
if necessary.

Downloading with Windows TWAIN Source [Still Images Only]
You can also load images into a program with the Microsoft TWAIN Source.
(Windows Me: The Microsoft TWAIN source cannot be used with ArcSoft
PhotoImpression.)

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  36).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The Scanners and Cameras Wizard opens automatically.

4. Click the [Cancel] button.

5. Start a TWAIN-compliant program, such as Adobe
Photoshop.

6. Open the dialog in which you can select the TWAIN source
and select [WIA-(your camcorder model)].

7. Start TWAIN Source.

8. Select the still image(s) you wish to download and click the
[Acquire] button.
• The selected still image(s) load into the program.
• The procedures for starting TWAIN-compliant programs and opening

their dialogs may vary between programs. Refer to the respective
program manual for more details.
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Printing Still Images (PhotoRecord)

1. Select the still image(s) you wish to print in the Browser
Display Area.
• Movies cannot be printed.

2. Click the [PRINT] button and select [Layout] from the
displayed menu.
• The PhotoRecord printing utility starts and the selected still image(s) will

be displayed in a page layout.

3. Select a print mode and click [Next].
• For the purposes of this example, please select [Artwork/Layout album].

4. In the next dialog, set the paper size and other settings and
click [Next].

5. In the last dialog, set the fine settings and click [Finish].
• The PhotoRecord window appears (  62).
• If you wish to change the layout, set the printing settings in the

PhotoRecord window.

6. Click the PhotoRecord [Print] button.
• The Print dialog appears.
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E7. Click [OK] to start printing.

 Notes:
• When you select the “Artwork/Layout album” option, you can resize or

reposition the still images freely for printing. The other print modes allow
you to do such things as tile the still images for printing or arrange them for
printing on Canon perforated paper. For more details, please refer to the
PDF manual, “ZoomBrowser EX Software User Guide” (  9).

• When you click the [Print] button and select [Index] from the displayed
menu, the Print Index dialog appears. Set the desired thumbnail size and
paper size, then click [Print] to start printing the index.

• Do not remove the memory card, detach the USB cable or turn off the
camcorder while data is being transferred to the printer (when the
camcorder’s card access indicator is flashing). Doing so may cause memory card
data to become corrupted.
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Click these buttons to 
select a layout pattern 
for each page. Click 
the arrow ▼ to display 
a pop-up menu.

Click this to switch 
between auto and 
manual layout mode.

Click this to set the 
printing mode or paper 
size.

Click this to change the 
page background or 
borders.

Click these buttons to undo or 
restore the previous action.

Click this to import still 
images.

Click this to display the 
Print Dialog.

Input titles or 
captions anywhere 
you wish.

Drag still images to 
change the layout.

Click this to stop 
importing still 
images.

Click this to display 
Help.

Switch between 
control panel sizes 
with this.

Slide this tab to the 
left to shrink the 
image, right to 
expend it.

The PhotoRecord Window

Printing Still Images (PhotoRecord)
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Merging Panoramic Images (PhotoStitch)

To Merge Images Registered in ZoomBrowser EX
You can merge a series of overlapping images into a single, seamless
panorama.

1. Select the still images in the Browser Display Area.

2. Click the [Edit] menu and select [PhotoStitch] to start the
program.

3. Select [1.Selection and Arrangement] and then click
[Arrange].
• Determine the sequence to be used for merging the still images.
• Operational instructions are displayed in the upper section of the

window.
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Merging Panoramic Images (PhotoStitch)

4. Select [2.Merge] and click [Start].

5. Select [3. Save] and then click [Save].
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Still images recorded in
Stitch Assist mode have a
green stitch mark. Click the
stitch mark to start
PhotoStitch and merge the
image series.

Still Images Recorded in Stitch Assist Mode

PhotoStitch automatically arranges still images recorded with the camcorder’s
Stitch Assist mode in their correct order and orientation, making it easy to
merge them. Still images recorded in Stitch Assist mode appear in the Camera
Window as shown below.

Please refer to the Camcorder Instruction Manual to learn how to record in
Stitch Assist mode.

 Notes:
• You can record the surroundings in 360 degrees, and stitch them together

later to form a 360-degrees cylinder. (In [1. Selection and Arrangement],
select [Arrange] and [360 degrees].) By saving this stitched image in
QuickTime VR format, you can then get a virtual view of the surroundings.
For this, you need to have QuickTime installed on your computer.  If it is not
already installed, install it from the Canon DIGITAL VIDEO SOLUTION DISK.
Place the disk in the CD-ROM drive and click [QuickTime 5.0 Installation] in
the installer panel.

• Please refer to the PhotoStitch Help menu for more details.
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Using a PC Card Reader/Writer

This section explains only the instructions which differ when connecting a PC
Card Reader/Writer instead of the camcorder.
For instruction on how to connect the PC Card Reader/Writer, please refer to
its manual.

Downloading Still Images/Movies with the ZoomBrowser EX

1. Insert the memory card or loaded PC card adapter into the
reader.

2. Start ZoomBrowser EX.
• Double-click the [Canon ZoomBrowser EX] icon on the desktop.
• If you are using Windows Me, a confirmation message will appear the

first time ZoomBrowser EX starts, asking whether you wish to register
the [My Pictures] folder in ZoomBrowser EX. Click [Yes] if you plan to
use the [My Pictures] folder.

3. Click the [Import Images] button and select [From
CANON_DV X:\ Dcim].
• Thumbnail versions of the camera images appear in the Camera

Window (  41).
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Adding Still Images from Your Computer to the Memory Card

You can copy still images from your computer to the memory card.

1. On the Camera Window, click [UPLOAD].
• A window for selecting still images to be added appears.

2. Select the image file you wish to add and then click [Open].
• The [Save to Camera] window appears.

3. Select [Camera Model].
• Select the model name of the camcorder you are using.

4. Select the image size and click [Save to Camera].
• [Large] corresponds to 1280 x 960 and [Small] to 640 x 480.
• [Adjust Height] and [Adjust Width] specify the standard for image

enlargement and reduction.
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Adding Card Mix and Card Animation Images to the
Memory Card
You can add card mix and card animation images to the memory card. 4
images for CARD CHROMA, 2 images for CARD LUMINANCE, 2 images for
CAMERA CHROMA and 4 images for CARD ANIMATION are provided on the
Canon DIGITAL VIDEO SOLUTION DISK.

1. Insert the DIGITAL VIDEO SOLUTION DISK to the computer’s
CD-ROM drive.

2. Click  (Upload).
• A dialog box appears.

3. Double-click the CD-ROM icon, followed by the [DVC CARD
IMAGE] folder.

4. Open the [CARD CHROMA], [CARD LUMINANCE], [CAMERA
CHROMA] or [CARD ANIMATION] folder, select the image
you wish to copy to the camcorder and click [Open].
• The [Save to Camera] window appears.

5. Select [Small] for [Image Size] and click [Save to Camera] (if
you are using a memory card reader, click [Save to Camera
Folder]).

 Notes:
• Image enlargement and reduction are not performed when both [Adjust

Height] and [Adjust Width] are deselected.
• When [Adjust Height] and [Adjust Width] are both selected, the aspect ratio

of the still image (the ratio between the height and width of  the image)
may change when the still image is resized.

• JPEG, Windows bitmap, TIFF and Windows Metafile format images can be
added to a memory card. Note, however, that an image becomes JPEG
format when it is stored on the memory card.

• You can also add still images to a memory card by using drag and drop to
move the image from the browser area to the camera window.

Adding Still Images from Your Computer to the Memory Card
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• To add multiple still images

Selecting multiple still images in step 2 of the above procedure undims the
[Save subsequent images with the same settings] button on the [Save to
Camera] window. Clicking this button makes it possible to add multiple still
images with a single setting operation.
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 Notes:
• If you have uninstalled ZoomBrowser EX because of a corrupt database file

or other problem, please also delete the Database folder, which can be
found within the [C:\Program Files\Canon\ZoomBrowser EX] folder.

• PhotoRecord and PhotoStitch can be removed with the same procedures.
• For uninstalling ArcSoft PhotoImpression and ArcSoft VideoImpression,

select [Start] menu, [Programs], [ArcSoft Camera Suite] and [Uninstall].

Uninstalling the Software

The following explanation uses the procedures for removing ZoomBrowser EX
as an example for removing other programs as well.

For uninstalling the USB TWAIN Driver and USB WIA Driver please refer to
following sections: Windows 98 (  16), Windows Me (  20), Windows
2000 (  24), Windows XP (  31).

Uninstalling the ZoomBrowser EX

1. Click the Windows [Start] menu and select [Programs],
[Canon Utilities], [ZoomBrowser EX] and [ZoomBrowser EX
Uninstall].
• The uninstall utility starts and removes ZoomBrowser EX.
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Troubleshooting

? Can’t download still images or camcorder is not recognized when
the camcorder is connected via the USB interface.

➜ Computer doesn’t support the USB interface.
The USB interface is not supported for computers not in compliance with
the following requirements. Acquire the necessary system to use the USB
interface.
Requirements
• Built-in USB interface on a system preinstalled with one of Windows 98/

Windows Me/Windows 2000/Windows XP.

➜ There is no memory card in the camcorder.
Insert a memory card into the camcorder.

➜ The camcorder is not set to the correct mode.
Slide the POWER switch to PLAY (VCR) and the TAPE/CARD switch to
CARD.

➜ Camcorder is not correctly connected to the computer.
Read “Connecting the Camcorder to a Computer” (  36) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

➜ If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.

➜ USB TWAIN Driver or USB WIA Driver is not installed properly.
First uninstall the USB TWAIN/WIA Driver, then reinstall the driver from the
Digital Video Solution Disk (remove the check marks from the other
programs when prompted to select the programs to be installed). For
uninstalling refer to the following section: Windows 98 (  16), Windows
Me (  20), Windows 2000 (  24), Windows XP (  31). For installing
refer to the following section: Windows 98 (  15), Windows Me (  20),
Windows 2000 (  24), Windows XP (  29).
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Troubleshooting

? Can’t install the TWAIN Driver, WIA Driver correctly.
First, Check the Following

➜ Does the system have a built-in USB port and did it come with
Windows 98 (First or Second Edition), Windows Me, Windows 2000,
or Windows XP preinstalled?

➜ Is the camcorder correctly connected to the computer?

➜ Are you using the AC power adapter to power the camcorder?

• If the Problem Is Not Mentioned Above
If the USB TWAIN Driver/USB WIA Driver has not correctly installed,
Windows may not recognize the driver.  Uninstall the driver according to the
instructions (  16, 20, 24, 31) and reinstall the USB Driver.

? ZoomBrowser EX displays a database file related error message
(E_Fail error, etc.)

➜ ZoomBrowser EX database file may be corrupted.
Please restore the database using the procedures described in the
“Troubleshooting” section of the PDF manual, ZoomBrowser EX Software
User Guide (  9).

? Images in the [My Images] folder, or the [Image Library One] folder
are not displayed after I installed a new version of ZoomBrowser
EX.

➜ On the browser window, select [Refresh Online Registered Folders]
from the [View] menu.
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Macintosh  System Requirements

Computer Model: Power Macintosh, PowerBook, iMac, iBook
OS: Mac OS 8.6-9.2, Mac OS X (10.1)
CPU: PowerPC
RAM: Mac OS 8.6-9.2: 20 MB or more of application memory

Mac OS X (Version 10.1): 128 MB or more of RAM
Interface: USB: only systems equipped with genuine

Apple-brand built-in USB interfaces
Free Hard Disk Space: • Canon Utilities

- ImageBrowser 20 MB or more
- PhotoStitch 30 MB or more

• USB Mounter: 5MB or more
• ArcSoft PhotoImpression: 120 MB or more
• ArcSoft VideoImpression: 30 MB or more

Display: 800 × 600 pixels/256 colors or better, 1,024 × 768
pixels/32,000 colors or better is recommended

• Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
• Proper operation is not guaranteed on any particular system, even if it meets

the requirements outlined above.
• A CD-ROM drive is required to install the software.
• Connect the camcorder directly to a USB port on the computer; not through a

hub. The connection may not operate correctly through a hub.
• The connection may not operate correctly if you are using other USB devices,

excluding USB mice or keyboards, at the same time. If this occurs, disconnect
the other devices from the computer and try reconnecting the camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained
on the CD-ROMs.

Canon DIGITAL VIDEO SOLUTION DISK

■ ImageBrowser (  79)
• Downloading still images/movies recorded onto a memory card to your

computer.
• Categorizing and Organizing Large Volumes of Still Images/Movies*.
• Searching and Organizing Images Chronologically*.
• Creating Mail Attachments from Still Images*.
• Laying Out and Printing Still Images.
• Printing Indexes.

■ PhotoStitch (  98)
• Merging Panoramic Images.

■ USB Mounter (Mac OS 9.X Only) (  93)
• This utility allows you to treat the camcorder like a computer drive or

read-only card reader, displaying the contents on the computer and
permitting files to be downloaded easily. The USB Mounter cannot be
used with Mac OS 8.X and 10.1.

 *: For instructions on these features, refer to the ImageBrowser Software
User Guide.

How to view the ImageBrowser Software User Guide

In order to view the ImageBrowser Software User Guide, it is required that
Adobe Acrobat Reader is installed on your computer. If it is not, install it
according to “How to install Adobe Acrobat Reader” below.

1. Place the Canon Digital Video Solution Disk in the CD-ROM drive.
2. Double-click the CD-ROM icon followed by the [Canon Digital Video

Installer] icon.
The installer panel will be displayed.

3. In the installer panel, click [Using the Software] and [ImageBrowser].
The guide will be displayed.

• You can also display it by opening the [Readme] and [English] folders on the
CD-ROM and double-clicking [IB_guide.pdf].

How to install Adobe Acrobat Reader
1. Place the Canon Digital Video Solution Disk in the computer’s CD-ROM

drive.
2. Open the [Readme], [Acrobat_English] folder.
3. Double-click the [Reader Installer] file to start the installer.
Follow the onscreen instructions to install Adobe Acrobat Reader.
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ArcSoft Camera Suite CD-ROM

■ ArcSoft PhotoImpression
This program allows you to easily convert still images recorded on a
memory card to sepia color, apply other special effects, or to edit them and
create greeting cards and calendars.

■ ArcSoft VideoImpression
This program provides simple procedures for editing and applying special
effects to movies recorded on a memory card, or for attaching them to your
e-mail.

This instruction manual explains how to install the software, what you can do
with the main features and how to operate them. For more detailed
operational instructions, refer to the ImageBrowser Software User Guide (PDF
format) or the Help menu of each software program.

Mac OS 8.6-9.2 only
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Installing the Software

Installing from the Canon DIGITAL VIDEO SOLUTION DISK

1. Close any programs that are running.

2. Set the Canon DIGITAL VIDEO SOLUTION DISK in the
computer’s CD-ROM drive.

3. Mac OS 8.6-9.2 : Double click the CD-ROM icon, followed by
the [Mac OS 8/9] and [Canon Digital Video Installer] icons.
Mac OS X (10.1) : Double click the CD-ROM icon, followed by
the [Mac OS X] and [Canon Digital Video Installer] icons.
• The installer panel appears.

4. Click [Digital Video Software Installation].

5. Follow the on-screen instructions to proceed with the
installation.

6. After the installation is complete, restart the computer as
prompted.

Installer Panel
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Installing from the ArcSoft Camera Suite CD-ROM

Installing ArcSoft PhotoImpression

1. Close all other programs that are running.

2. Place the ArcSoft Camera Suite CD in the computer’s CD-
ROM drive.

3. Double-click the CD-ROM icon, followed by the [English] and
[PhotoImpression Installer] icons.
• Installation starts. Follow the on-screen messages to proceed with the

installation.

4. Click the [Quit] button when a message tells you that the
installation is complete.
• Continue by installing ArcSoft VideoImpression.

Installing ArcSoft VideoImpression

5. Double-click the [English] folder icon within the CD-ROM,
followed by the [VideoImpression 1.6 Installer] icon.
• Installation starts. Follow the on-screen messages to proceed with the

installation.

6. When the installation is complete, restart the computer.
• This concludes the process for installing ArcSoft PhotoImpression and

ArcSoft VideoImpression.

Mac OS 8.6-9.2 only
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Connecting the Camcorder to a Computer

Connecting to a USB Port

Connection Precautions
• Make sure the camcorder is being powered using the power adapter before

connecting it to a computer.
• Be sure to install the DIGITAL VIDEO SOLUTION DISK before you connect the

camcorder to the computer.
• Connect the camcorder directly to a USB port on the computer; not through

a hub. The connection may not operate correctly through a hub.
• The connection may not operate correctly if you are using other USB

devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.

• Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface. If it does happen,
never disconnect the USB cable. Try to awaken the computer with
the camcorder in the connected state. Some computers will not
awaken properly if you disconnect the camcorder while they are in
standby mode. Please refer to your computer manual for instructions
regarding its standby mode.

1. Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
• You do not need to turn off the computer for this procedure.
• Refer to your computer manual for the location of the computer’s USB

ports.
• See your camcorder instruction manual for connecting instructions.

USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer
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• Observe following precautions when the camcorder’s card access indicator is
flashing (the camcorder is reading or writing from or to the memory card).
Failure to do so may cause memory card data to become corrupted.
– Do not remove the memory card or detach the USB cable.
– Do not turn off the camcorder or the computer.
– Do not change the position of the POWER switch or the TAPE/CARD switch.

• Format the memory card with the camcorder or from the Camera Window
(  84).

• Still images/movies recorded onto the memory card or downloaded to the
hard disk are important original data files. Create a copy of the file first
before working on it on your computer.

Starting the ImageBrowser

1. Insert the memory card to the camcorder.
• When connecting a PC card reader, see “Using a PC Card Reader”

(  82).

2. Connect the Power Adapter to the camcorder.

3. Connect the camcorder to the computer using the supplied
USB cable (  78).

4. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• ImageBrowser starts and the ImageBrowser Automation Wizard dialog

appears.

5. Select [Display Images] and click the [OK] button.

• The Communications Settings dialog appears. This dialog only appears
the first time the camcorder is connected.

Downloading Still Images/Movies with the ImageBrowser

Mac OS 8.6-9.2
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Downloading Still Images/Movies with the ImageBrowser

6. Confirm that [USB port] and your camcorder model name are
selected and click the [Set] button.

• The Camera Window opens and displays the camcorder still images/
movies as thumbnails.

 Notes:
• In the ImageBrowser Automation Wizard dialog, you can select the action

that is carried out after ImageBrowser starts.
• A dialog with the previously selected automated settings will appear the

next time you start ImageBrowser.
1. To use these settings unchanged, click the [Start] button.
2. To do nothing, click [Cancel].
3. To change the settings, click [Settings Change], select the action and

click [OK].
• For more details, please refer to the PDF manual, “ImageBrowser Software

User Guide” (  74).

Your camcorder model name
appears here.
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Starting the ImageBrowser

• Do not connect the camcorder while the Classic environment is started.
Likewise, do not start the Classic environment while the camcorder is
connected.

1. Insert the memory card to the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Connect the camcorder to the computer using the supplied
USB cable (  78).

4. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

5. Double-click the [Canon ImageBrowser] icon on the desktop.
• If the Canon ImageBrowser icon does not appear on the desktop,

double-click the [Canon Utilities] folder on the drive on which the
program was installed, followed by the [ImageBrowser] folder and
[ImageBrowser] icon.

How to Set ImageBrowser to Not Start Automatically

1. Click the Apple menu  and select [Control Panels] and
[Canon ImageBrowser Auto Launch].
• The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the
check mark.

3. Click the close box  at the upper left to close the dialog.
• ImageBrowser will cease to start automatically thereafter.

Click here to close the dialog.

Mac OS X (10.1)
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Downloading Still Images/Movies with the ImageBrowser

6. Click [Canon Camera] in the Explorer View section.
• The Communications Settings dialog is displayed.

7. Click the [Set] button.
• The Dialog appears only for the first connection.
• The Camera Window will open and display the camera images as

thumbnails (  83).

Using a PC Card Reader
For instruction on how to connect the PC Card Reader, please refer to the PC
Card Reader Manual.
The PC card reader will be treated as a read-only card reader.

1. Insert the memory card or loaded PC card adapter into the
reader.
• Mac X (10.1): If a dialog appears, click the red close box.

2. Start ImageBrowser.
• Double-click the [Canon ImageBrowser] icon on the desktop.

• If the icon does not appear on the desktop, double-click the folder in
which you installed the program, followed by the [Canon Utilities] and
[ImageBrowser] folders and the [ImageBrowser] file.

3. Double-click the [CANON_DV] and [DCIM] folders in the
Explorer View Section.
• The images from the memory card appear as thumbnails in the Camera

window (  83).

Canon ImageBrowser Icon

Explorer View Section
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Thumbnail
The still image/movie* is 
displayed reduced in size.

Delete Button
Deletes selected still 
images/movies.

Download Button
Copies selected still 
images/movies 
onto the computer 
(      86).

Upload Button
Copies still images/movies 
from the computer onto the 
memory card (      101).

Print Layout Button
Selects the printing 
method: Layout or Index.

The ImageBrowser Camera Window
The Camera Window opens when a connection to a camcorder is initiated.
Still images/movies will be displayed as thumbnail (small) images.
Buttons are activated when a still image/movie is selected.

* Movies are displayed with the first scene as a still image, indicated with a
movie icon.

 Notes:
About the other buttons
• [SELECT]: Selects or deselects all images.
• [ROTATE]: Rotates the image (90 degrees counterclockwise/90 degrees

clockwise/180 degrees).
• [IMAGE INFO]: Displays the number of pixels and file size of the selected

image.
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Downloading Still Images/Movies with the ImageBrowser

• [SLIDE/DPOF]:
 - The SLIDE function (selecting a still image to be included in the slide show)

cannot be used.
 - The DPOF index print and date/file name settings are not supported by the

camcorder. Therefore, setting or erasing a print mark on the camcorder will
cancel the index print and date/file name setting.

 - The [DPOF] setting in the ImageBrowser allows marking up to 998 still
images for printing.

Mac OS X (10.1): Be careful when erasing images in the ImageBrowser
Camera Window. Even images you protected with the camcorder will be
erased permanently.

Input a camcorder owner name here 
(up to 31 characters).

Set the date and time here.

Click this button to synchronize the camcorder 
to the computer’s date and time settings.

Check the battery charge here.

Click this to format the memory card in the camcorder. 

Check the remaining memory capacity here.

How to Check and Change Various Camera Settings

You can adjust the date, time and owner settings in the Camera Settings
dialog using the computer when the camcorder is connected. You can also
check the remaining memory capacity.

1. Click the [Setup Options] button and select [Camera Settings] from the
displayed menu.

2. Check or change the settings.
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Image Name
This is where 
the file name 
of each 
individual still 
image/movie 
is displayed.

Explorer View Section
Displays the disks and folders 
that you can use on your 
computer.
If you click the disclosure triangle 
on the left edge of the display, 
you can switch between 
collapsing and expanding the 
contents of that folder.

You can drag this line to 
change the position of the 
boundary between the 
Explorer View Section and 
the Browser Area.

You can drag this part 
of the frame to change 
the size of the Browser 
Window.

Control Panel
This area contains 
buttons that allow you 
to perform a variety of 
functions.

Browser Area
This is the area where thumbnails of still 
images/movies in the selected folder are 
displayed.

The Browser Window
This section describes the various parts of the Browser Window display.
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Downloading Still Images/Movies with the ImageBrowser

Explorer View Section

Downloading and Saving Still Images/Movies from the Camcorder
When using the ImageBrowser’s Camera Window to download images from
the camcorder’s memory card, make sure to select [Macintosh HD]. The image
will not be saved to the computer when [DCIM] is selected. Follow the
instructions below.

1. Mac OS 8.6-9.2 : Select [Macintosh HD] in the explorer view
section.

Mac OS X (10.1) : Select the [  (user name)] subfolder of the
[Users] folder in [Macintosh HD].

2. Create a new folder for saving images from the memory card
in the camcorder.
• Click the [File] menu and select [New Folder]. A folder with the name

“Untitled” will be created. Click it to change the folder name as you wish.
In this example, we will input “Travel.”

3. In the Explorer View Section, click the newly created folder.
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Thumbnail

Explorer View Section

Browser area

4. Select still images/movies in the Camera window and click
the [DOWNLOAD] button.
• Click a thumbnail to select it or press [Shift] and click to select multiple

thumbnails. The color of the frame(s) around the thumbnail(s) you
selected will change to blue.

• Downloaded still images/movies are saved to the computer and appear
in the Browser area.

To disconnect the camcorder, click the close box (Mac OS 8.6-9.2) or the red
close box (Mac OS X (10.1)) at the upper left of the Camera Window. The
Camera Window will close.
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 Notes:
• Double-clicking a still image/movie on the camera window imports it to the

computer.
• You can also download still images/movies to the computer by dragging

them from the Camera window and dropping them on the Browser area or
the Explorer View Section.

• You can select multiple still images/movies by holding down [Shift] or
[Option] + [Shift] while clicking.

Downloading Still Images/Movies with the ImageBrowser
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Using Other ImageBrowser Functions

Playing Back Movies From a Memory Card
When you double-click an image with a movie icon in the Browser Area,
QuickTime Player starts and plays back the movie.
• Movies are displayed with the first scene as a still image.

1. Double-click a thumbnail with a movie icon.
• QuickTime Player starts.

2. Click the PLAY button in QuickTime Player.
• The movie will be played back.

Saving a Start-up Image to the Memory Card
You can add your favorite images from your computer to the memory card.
This topic explains how to upload a still image saved on your computer as
start-up image to the memory card. Use ImageBrowser to perform this
function.
For a more detailed explanation, please refer to the ImageBrowser Help menu
or PDF manual, “ImageBrowser Software User Guide” (  74).

Displaying the [DVC My Camera] Window

To save a start-up image to the memory card, use the [DVC My Camera] window.
The following explains the procedure for displaying the [DVC My Camera] window.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  78).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• ImageBrowser will start and display the [ImageBrowser Automation]

dialog.
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4. Confirm that [Display images] is selected and click the [OK]
button.
• The Camera Window appears.

5. From the [Edit] menu in the Browser Window, select [My
Camera for Digital Video Cameras].
• The [DVC My Camera] window appears.

 Note:
• ImageBrowser already contains several pre-recorded My Camera Settings

items. You can check these items with the [DVC My Camera] window.

The [DVC My Camera] Window

Using Other ImageBrowser Functions

Add Button
Adds images as start-up
image to the [Computer] list
when clicked.

Displays the start-up images
saved to the computer.

Displays the image
when it is selected.
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Saving the Start-up Image to the Memory Card

You can save the start-up image displayed in the [DVC My Camera] window
to the memory card.

• Image files that do not appear in the [Computer] list of the [DVC My Camera]
window cannot be saved to the camcorder.

• Do not detach the USB cable, turn the camcorder power off, or disconnect the
camcorder from the computer while the My Camera Settings is being saved to
the camcorder.

1. Select the start-up image you wish to save to the camcorder
from the [Computer] list and click the  button.
• When you select a start-up image, the image thumbnail appears on the

right of the window.

2. Click the [Close] button to close the window.
• This concludes the process for saving the start-up image to the memory

card.

To use the start-up image on the camcorder, you need to change the start-up
image on the camcorder itself. Please see the Instruction Manual of the
camcorder for these procedures.
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Adding New Image Files to the [DVC My Camera] Window

Create a start-up image using an image editing application program, such as
ArcSoft PhotoImpression. Create the file in the JPEG format at a size of 1280 x
960 or 640 x 480 pixels. Image files not in the JPEG format cannot be added.

Once you have created the start-up image and saved it to the computer, use
the following procedures to add it to the [DVC My Camera] window (  90).

1. Open the [DVC My Camera] window, and click the [Add]
button.

2. Select the file you created in the [Open file] dialog and click
the [Open] button.
• The selected file appears in the [Computer] list.

This concludes the process for adding new data.

You can save the newly created file to the memory card using the procedures
described in “Saving the Start-up Image to the Memory Card” (  91).

 Note:
• To delete a data file, select it and click the [Delete] button.

The newly added data will
appear here

Using Other ImageBrowser Functions
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Downloading Still Images/Movies with the USB Mounter (Mac OS 9.X Only)

This utility allows you to treat the camcorder like a computer drive or read-
only card reader, displaying the contents on the computer and permitting files
to be downloaded easily.
When you open still images or playback movies, be sure to download them
from the memory card to the computer first, then open or play them back.
• The USB Mounter cannot be used with Mac OS 8.X or 10.1.

If you enable the USB Mounter, the camcorder will be treated as if it were a
drive like a card reader. Consequently, the following cannot be performed
while the USB Mounter is running.
- ImageBrowser cannot be automatically started when the USB connection is

opened.
- Still images/movies cannot be deleted from the memory card in the

camcorder. Still images/movies on the computer cannot be uploaded to the
camcorder.

Enabling the USB Mounter

To download still images/movies with the USB Mounter, enable it with the
following procedures.

1. Select [Control Panels] from the Apple menu and [Canon USB
Camera Driver].
• The [Canon USB Camera Driver] control panel appears.

2. Select [Card Reader Mode] and close the control panel.
• A dialog prompting you to restart the computer appears.

3. Click [Yes] to restart the computer.
• The USB Mounter is enabled.
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Disabling the USB Mounter

1. Select [Control Panels] from the Apple menu and [Canon USB
Camera Driver].
• The [Canon USB Camera Driver] control panel appears.

2. Select [Camera Mode] and close the control panel.
• The USB Mounter is disabled.

Downloading Still Images/Movies

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (  78).

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
• The camcorder icon appears on the desktop.

4. Double-click the camcorder icon.

5. Select the folder containing the still images/movies.
• The still images/movies on the memory card are displayed as file icons.

6. Copy still images/movies to the computer’s hard disk using
standard file copying procedures.
• Select still images/movies and drag and drop them into the target folder

on the computer to download them.

Never turn off the power or detach the USB cable while copying the file to the
hard disk. The operation may not work properly.

Disconnecting the Camcorder

1. Move the icon of your camcorder model into the Trash.

2. Turn off the camcorder and detach the USB cable.
• Pull the USB cable by its connector when detaching it from the

camcorder and computer.
• Turn the camcorder off before inserting/removing a memory card.
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Printing Still Images (ImageBrowser)

1. Select the still image(s) you wish to print in the Browser
Window.
• Movies cannot be printed.

2. Click the [PRINT] button and select [Layout printing] from
the displayed menu.

3. In the Layout Options window, select the desired layout and
click the [Next] button.
• Select the [Custom layout printing] option for the purposes of this

example.

Layout Options Window

Print Window
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Printing Still Images (ImageBrowser)

4. In the next window, select a paper size and click the [OK]
button.
• The Layout Options window closes and the Print window opens,

allowing you to change the layout and printing settings.
• The settings available in Step 4 will vary according to the type of layout

selected in Step 3.

5. Click the [PRINT] button in the Print window.
• The Print dialog appears.

6. Click [OK] to start printing.

 Note:
• The Custom Layout printing option in the Layout Options window allows

you to freely change the size and position of the still images for printing.
The other options allow you to print an index or print onto Canon
perforated paper. For more details on the Layout Options window, please
refer to the PDF manual, ImageBrowser Software Guide (  74).

• Do not remove the memory card, detach the USB cable or turn off the
camcorder while data is being transferred to the printer (when the
camcorder’s card access indicator is flashing). Doing so may cause memory card
data to become corrupted.
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Change the Image 
Size
Drag the border to 
resize the still image. 

Change the default 
number of still images 
printed per page. 

Click this to rotate the 
selected still image.

Click this to reset the 
layout.

Edit the Page Title
Open the [Edit] 
menu and select 
[Edit Header].

Change the Layout
Drag the still image 
to change the 
layout.

Click this to select a 
layout type.

Click this to display 
the Print dialog.

Add Text
Open the [Edit] 
menu and select 
[Add Text].

Add Captions to Still 
Images
Click the still image 
and then the [Edit] 
menu and select [Edit 
Caption].

The Print Window
When the Custom layout printing option is selected in the Layout Options
window, you can freely change the size and position of the still images for
printing.
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Merging Panoramic Images (PhotoStitch)

To Merge Still Images Registered in ImageBrowser
You can merge a series of overlapping images into a single, seamless
panorama.

1. Select the still images in the Browser Window.

2. Click the [Edit] menu and select [PhotoStitch] to start the
program.

3. Select [1.Selection and Arrangement] and then click
[Arrange].
• Determine the sequence to be used for merging the still images.
• Operational instructions are displayed in the upper section of the

window.
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Still images recorded in
Stitch Assist mode have a
green stitch mark. Click
the stitch mark to start
PhotoStitch and merge
the image series.

4. Select [2.Merge] and then click [Start].

5. Select [3. Save] and then click [Save...].

Still Images Recorded in Stitch Assist Mode

PhotoStitch automatically arranges still images recorded with the camcorder’s
Stitch Assist mode in their correct order and orientation, making it easy to
merge them. Still images recorded in Stitch Assist mode appear in the Camera
Window as shown below.

Please refer to the Camcorder Instruction Manual to learn how to record in
Stitch Assist mode.
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Merging Panoramic Images (PhotoStitch)

 Notes:
• You can record the surroundings in 360 degrees, and stitch them together

later to form a 360-degrees cylinder. (In [1. Selection and Arrangement],
select [Arrange] and [360 degrees].) By saving this stitched image in
QuickTime VR format, you can then get a virtual view of the surroundings.

• For more details, please refer to the PDF manual, ”ImageBrowser Software
User Guide“ or the PhotoStitch Help menu.
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Adding Still Images from Your Computer to the Memory Card

You can copy still images from your computer to the memory card.

1. On the camera window, click [UPLOAD].
• A window for selecting images to be added will appear on the display.

2. Select the still image file you wish to add and then click
[Open].
• The [Save to Camera] window will appear on the display.

3. Select [Camera model].
• Select the model name of the camcorder you are using.

4. Select the image size and click [Save to Camera].
• [Large] corresponds to 1280 x 960 and [Small] to 640 x 480.
• [Adjust Height] and [Adjust Width] specify the standard for image

enlargement and reduction.
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Adding Still Images from Your Computer to the Memory Card

Adding Card Mix and Card Animation Images to the
Memory Card
You can add card mix and card animation images to the memory card. 4
images for CARD CHROMA, 2 images for CARD LUMINANCE, 2 images for
CAMERA CHROMA and 4 images for CARD ANIMATION are provided on the
Canon DIGITAL VIDEO SOLUTION DISK.

1. Insert the DIGITAL VIDEO SOLUTION DISK to the computer’s
CD-ROM drive.

2. Click  (Upload).
• A dialog box appears.

3. Double-click the CD-ROM icon, followed by the [DVC CARD
IMAGE] folder.

4. Open the [CARD CHROMA], [CARD LUMINANCE], [CAMERA
CHROMA] or [CARD ANIMATION] folder, select the image
you wish to copy to the camcorder and click [Open].
• The [Save to Camera] window appears.

5. Select [Small] for [Image Size] and click [Save to Camera] (if
you are using a memory card reader, click [Save to Camera
Folder]).

 Notes:
• Still image enlargement and reduction are not performed when both [Adjust

Height] and [Adjust Width] are deselected.
• When [Adjust Height] and [Adjust Width] are both selected, the aspect ratio

of the still image (the ratio between the height and width of  the image)
may change when the still image is resized.

• Still images in JPEG, TIFF, PICT, and Windows bitmap file format can be
added to a memory card. However, the still images are saved in JPEG format
on the memory card.

• You can also add still images to a memory card by using drag and drop to
move it from the browser area to the Camera window.
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• To add multiple still images
Selecting multiple still images in step 2 of the above procedure undims the
[Save subsequent images with the same settings] button on the [Save to
Camera] window. Clicking this button makes it possible to add multiple still
images with a single setting operation.
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Uninstalling the Software

Uninstalling Application Programs
Move the program’s folder into the Trash to uninstall programs such as
ImageBrowser and PhotoStitch.

 Note:
• If the program folders contain subfolders into which still images/movies

have been saved, be careful not to accidentally delete those subfolders.
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Troubleshooting

This topic explains some of the causes for and solutions to problems with the
software.

? Can’t download images, camcorder is not recognized when the
camcorder is connected via the USB interface.

➜ Computer doesn’t support the USB interface.
The USB interface is not supported for computers not in compliance with
the following requirements. Acquire the necessary system to use the USB
interface.
Requirements
• Genuine Apple Computer brand computer with a built-in USB interface.

➜ There is no memory card in the camcorder.
Insert a memory card into the camcorder.

➜ The camcorder is not set to the correct mode.
Slide the POWER switch to PLAY (VCR) and the TAPE/CARD switch to
CARD.

➜ Camcorder is not correctly connected to the computer.
Read “Connecting the Camcorder to a Computer” (  78) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

➜ If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.
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